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MOVING-MAP COMPOSER–PERSONAL COMPUTER (MMCPC) VERSION 2.0 SOFTWARE 
USER’S MANUAL  

1. INTRODUCTION

This report documents a substantial revision of the Moving-Map Composer-Personal Computer 
(MMCPC) system designed and developed by scientists at the Naval Research Laboratory, 
Marine Geosciences Division. MMCPC v2.0 has been reconfigured and modified to support the 
map development planning needs for the C-130J Map File Data Cartridge (MFDC) system versus 
the MMCPC v1.0 original intent of supporting the Tactical Aircraft Moving Map Capability 
(TAMMAC) system. MMCPC is specifically designed and configured to support Kuwait Air Force 
KC-130J mission planners and pilots in the field for map data planning and cartridge loading for 
the MFDC. 

MMCPC v2.0 is a software-only application intended for target installation on a Windows 10 
computer configured with a PCMCIA drive for creating, writing, and reading MFDC theater map 
data loads. MMCPC v2.0 enables users to perform the following major functions:  

• Ingest Compressed ARC Digitized Raster Graphics1 (CADRG) into MMCPC via data logging;
• Create and save map coverages (map compositions) based on available logged data sources

at multiple scales for map theater data loads as a series of bitmap representations;
• Build map theaters from valid map compositions with map data from logged CADRG data

sources that fit within the constraints defined by the MFDC and PCMCIA card size;
• Write map theaters to a specified drive that should be pre-configured for PCMCIA cards.

Note that MMC v2.0 specifically does not support the following functions previously implemented 
in MMCPC v1.0 due to reduced scope for this effort: 

• Process source GEOTIFF files into a CADRG-compatible format;
• Process Digital Terrain Elevation Data (DTED) into TAMMAC-compatible Regridded DTED

(RDTED);
• Support the ability to ingest or utilize RDTED, CIB, or static data frames for map coverage

definition or build;
• Generate TAMMAC-compatible map theater or mission data loads.

_________
Manuscript approved September 26, 2018.
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2. QUICK START GUIDE 

A. Start MMCPC 
1. Unzip the MMCPC installation to a folder on your Windows 10 computer. 
2. Click on MMCPC.EXE to start the application. 
3. Click Yes if a message appears titled “Directory(s) Does not Exist” to create directory paths needed for MMCPC. 
 

B. Verify Viewing options 
1. Click View on the main menu and verify the following setting are on: 

 World Map 
 Lat/Lon Grid 
 Available coverage  

 
C. Log Data 

1. Click Log on the main menu, then Log Source.  “Logging Mode” appears at lower-right (below lat/lon display). 
2. In the Log dialog box, select Browse to navigate to a valid CADRG dataset to log into MMCPC.  

2.1. Select the directory name located one-directory level above the RPF directory. 
2.2. The name must be unique; otherwise, MMCPC will prompt to overwrite or cancel in a later step.  

3. Verify Found Valid Source Data is checked. If not checked, data source is invalid, click Cancel, repeat step 1. 
4. Notice the name of the selected directory now appears in the Processed Data Name field. Click Log. 
5. If the name is not unique, MMCPC will prompt to overwrite the current logged source. 
6. Wait until the progress indicator is dismissed and the Log Source completion dialog appears. Click Ok. 
7. Locate the logged source data. 

7.1. Select the chart scale of the logged source from the pulldown scale menu. 
7.2. The logged coverage will be displayed as a group of green boxes.  
7.3. Right-mouse click on the base map and select Zoom by Stretch Box. 
7.4. Hold down the left-mouse button and draw a box over the area of interest to zoom in.  
7.5. Large-scale data (e.g. 1:12.5K) may require zoom to be visible on the world base map.   

8. Repeat steps (1) – (6) to log all valid CADRG datasets needed. 
 

D. Compose Coverage (create a map composition) 
1. Click New to start composing mode and to activate drawing tools. “Composing Mode” appears at lower-right. 
2. Toggle any of the drawing tools to include coverage at any scale(s) where logged data exists (green). 
3. Selected coverage is red with a green checkmark set for scale(s) where map coverage has been added. 
4. Once completed adding coverage, click Compose, then Verify Composition to make sure your map composition fits 

within the size constraints pre-defined in your configuration.  Adjust your composition size accordingly. Click Ok. 
 

E. Map Theater Build 
1. Click Build on the main menu, then Build Map. 
2. In the Save Composition dialog, enter a name for the Composition, then click Ok. 
3. In the next dialog, the full composition name is shown. Click Ok. 
4. The Data Sources Needed dialog lists the map data IDs needed (you can modify order of preference). Click Ok. 
5. Wait until the progress indicator is dismissed and the Map Build completion dialog appears. Click Ok. 
 

F. Write a Map Theater to a device [PCMCIA card(s)] 
1. Click Build on the main menu, then Write Theater Map. 
2. “Building Mode” is now displayed in the lower-right portion of the screen. 
3. In the Select Map Build dialog, select the name of the map theater built above in step E. 
4. The selected composition appears in the Map Build Name field. Click OK. 
5. The PC Card drive dialog appears. Enter a disk into the pre-configured designated drive and click OK. 
6. Wait until the progress indicator is dismissed and the Map Build completion dialog appears. Click Ok. 
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3. SYSTEM CONFIGURATION 
  
Figure 1 illustrates the MMCPC operational components, data flow between each of these 
components, and the principal MMCPC software operations:  

 
• Log data sources;  
• Create a geographic map coverage (map composition) based on logged sources; 
• Build a map theater from a map composition; 
• Writing the map theater to a pre-configured disk drive assumed to be installed as the PCMCIA 

card drive. 
 
Map compositions are user-defined regions of interest based on logged sources for CADRG map 
data.  Figure 2 outlines how to create a new map composition.  

  
The main body of this manual provides detailed information on the MMCPC v2.0 software. Section 
4 describes the graphical user interface (GUI), including the world-map workspace, tool bars, and 
associated utilities. Section 5 provides step-by-step instructions on how to perform the most 
common operations. Acronyms and terms are defined in Appendix A.  Appendix B lists the 
modified ASCII symbol set, and Appendix C contains the Mission Planning System (MPS) import 
file format. 
 
NOTE: While some figures within this document have been updated to reflect specific 
MMCPC v2.0 features and capabilities, others are older images from MMCPC v1.0 where 
the significant functionality discussed has not been changed.  In those other images, there 
may be ancillary menu items displayed that are not included as part of MMCPC v2.0. 

Log source data Create a  map 
Composition

Build a map 
Theater from a 

Composition

Write Theater 
PC card

Figure 1 MMCPC operational components 



 

4 
 

 
 

Figure 2 Create a map composition (Note: new edition functionality disabled in MMCPC v2.0) 
  

4. GRAPHICAL USER INTERFACE 
 Some screen captures have been updated to reflect specific v2.0 functionality changes. 
 
4.1. Starting MMCPC  

  
MMCPC is invoked by clicking on the file named MMCPC.EXE that has been previously stored in 
a folder on your PC, which brings up the main MMCPC window (figure 3).  

  
Section 4.2 provides detailed descriptions and illustrations of the workspace, menus, tools, and 
title bar. Section 4.3 provides detailed descriptions of operations accessed from the main menu.  
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4.2. Toolbars and Workspace Definitions  
 
4.2.1. World-map Workspace  
  
Figure 3 depicts the main MMCPC window, primarily consisting of a world base map, in Mercator 
projection, on which to design map compositions.  

  
  

 

              
Figure 3 Main MMCPC window 

  
The cursor latitude/longitude position box (located in the lower right corner of the workspace) 
shows the current geographic position of the cursor over the MMCPC base map. Position can be 
shown in degrees, minutes and seconds [default] or in decimal degrees of latitude and longitude.  
The preference can be changed in the View menu, under Properties. 

  
Shortcuts for common base map operations are available by clicking the right mouse button over 
the map to invoke the shortcut selection window (figure 4):  

  
Full View to restore the world base map to full view (e.g., following a zoom operation).  
Zoom by Stretch Box to zoom into a region of interest using the “stretch-box” tool (Section 
4.2.2.3).  
View RPF Data to display geographic areas of coverage for Raster Product Format (RPF) 
data. This option is only active when clicking on a selected map coverage for a composition 
(i.e., red map tiles).  
Hide Lat/Lon Display to toggle on/off the cursor latitude/longitude position box.  
 

  

World-map 
workspace 

Tool 
bar  

Main 
menu   

Title bar 
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Figure 4 Base map shortcuts (access by clicking right mouse button anywhere on map) 

  
  

4.2.2. Tool Bar  
  

MMCPC provides tools to quickly access common operations, also available through main menu 
options. This section describes the functionality of each tool group. The descriptions that follow 
are keyed to the tool bar illustrated in figure 5:  

  
1. File buttons (Section 4.2.2.1)  
2. Data type and scale boxes (Section 4.2.2.2)  
3. Zoom buttons (Section 4.2.2.3)  
4. Build and Write buttons (Section 4.2.2.4) 
5. Coverage definition buttons (Section 4.2.2.5)  
 

 
 

 
 

 
Figure 5 MMCPC tool bar with all selectable options 

 
  

MMCPC displays the name of a toolbar button in a screen tip when the mouse pointer rests on 
the button. Tool bar fields may be selectively included or removed from view in the main window. 
Place the mouse cursor within any of the toolbars and click the right mouse button to invoke the 
tool bar view selection window (figure 6). Select a viewing preference by placing a check mark 
next to the desired tool bars.   

 

1 2 3 4 5 
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Figure 6 MMCPC tool bar view selection 

 
  

4.2.2.1.  File Buttons  
  

The File buttons (figure 7) are shortcuts for common operations also available via the File menu 
(Section 4.3.1), including opening new or existing files and performing save operations. File 
buttons may be selectively included or removed from the tool bar by clicking the mouse right-
button and toggling the Standard tool button on/off (adding or removing the check mark; see figure 
6).  

  

 
Figure 7 File buttons: Create composition, Open file, Save file, Import/Export 
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The Create a New Composition button enables map composition drawing tools in 
preparation for building a new map composition (Section 4.3.1.1).  
  
  
The Opens an existing composition button opens an existing composition file (Section 
4.3.1.2).  
  
  
  
The Save File button saves an open composition file (Section 4.3.1.4).  
  
  
    
  
The Import/Export button imports map compositions in ASCII file format (Section 
4.3.1.6).  The Mission Planning System (MPS) format required for import is defined 
in Appendix C.   
  

  

 
4.2.2.2.  Data Type and Scale Boxes  

  
Select the map data type and map scale from these drop-down lists (figure 8). MMCPC V2.0 only 
supports CADRG data. Users can define coverages in one map scale and switch to another 
map scale without losing what they defined in the first.  

 
 

 
Figure 8 Map data type and scale boxes 
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This option is not selectable in MMCPC v2.0.  Only CADRG is supported.   
    
  
Choose the map Data Scale from this drop-down list: select one  of the following 
scales:  1:5M, 1:2M, 1:1M, 1:500k, 1:250k, 1:100k, 1:50k, and 1:12.5k.  
  

 
 
  

4.2.2.3. Zoom Buttons  
  

To optimize performance, the user is advised to zoom-in to a region of interest before designing 
a composition. The Zoom buttons (figure 9) allow the user to zoom into (or out of) an area of 
interest on the MMCPC base map. Zooming can be accomplished via stretch-box or by selecting 
a zoom factor and then mouse click on the base map.  Note when using the zoom factor 
(percentage) icon:  By default 100% is world view; to zoom in select a percentage less than 100%; 
to zoom out choose a percentage greater than 100%.  Choosing a zoom percentage greater than 
100% at world view will result no action.   

  

 
Figure 9 Zoom buttons 

 

  
The Zoom-in to ROI via factor box button adjusts the zoom factor with the pop-up 
magnification selection box (figure 10). The default magnification (100%) displays the 
entire world base map. Factor values of 75% or less will zoom-in centered to the point 

selected. Choosing a zoom percentage greater than 100% at world view will result no action.   
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Figure 10 Zoom factor selection box 

  
  

  
The Zoom-in on a Point button zooms in to the MMCPC base map. Click on this button, 
adjust the zoom factor, and then click on the map to zoom-in (the map will center on 
the selected point).  
  
The Zoom-out from a Point button zooms out from the MMCPC base map. Click on 
this button, and then click on the map to zoom-out (the map will center on the selected 
point).  
  
The Zoom-in on a Stretch-Box button zooms in to an area of interest with a stretch-
box. Click on this button, then click on the upper left corner of the area of interest with 
the left mouse button, holding the mouse button down and dragging the resulting 
stretch-box to the lower right corner of the area of interest. As long as the mouse 
button is pressed, the stretch-box may be adjusted. The box maintains a constant 
aspect ratio identical to the display screen. As soon as the box is satisfactory, release 
the mouse button (figure 11).  
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Figure 11 Zooming in to an area of interest: (a) before zoom, (b) after zoom 

  
  
 

4.2.2.4. Build/Write Map Buttons  
  

The Build/Write Map buttons (figure 12) are shortcuts for common operations also available via 
the Build menu (Section 4.3.5), including building map loads and writing them to PC card(s).  

  
  
  
 
 
 
 

( a)    
  

( b)    
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Figure 12 Build/Write Map buttons 

 
  

  
Build Map button builds a map theater (see Section 4.3.5.1).  
  
  
   
  
The Write Theater Map button writes a map theater to PC card(s) (see Section 4.3.5.2).  
  

  
  

 
  

4.2.2.5. Coverage Definition Buttons  
  

The Coverage Definition buttons (figure 13) allow a user to define or modify map coverage. The 
coverage definition buttons are activated once MMCPC is in compose mode (via File -> New or 
File->Open).  Once activated, the user simply clicks on one of the buttons thereby highlighting 
that particular button to turn on that function.  This section describes the button functionalities that 
serve this purpose.   
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Figure 13 Coverage Definition buttons 

  
  

Define Area of Coverage: Use any combination of these four buttons to define an area or 
areas of map coverage for inclusion in a theater or mission composition.  

  
 
The Define Coverage by a Stretch-Box button defines a rectangular area of coverage 
using a stretch-box. Click this button, then click on the upper left corner of the area to be 
defined with the left mouse button. Hold the mouse button down and drag the  
resulting stretch-box to define the desired area. As long as the mouse button is 
depressed, the stretch-box is adjustable. Release the mouse button when the box is 
satisfactory.  

  
  
The Define Coverage by Clicking Polygon Vertices button defines an irregularly shaped 
area. Click this button, and then click a series of points (with the left mouse button) on 
the world map to define the vertices of a polygon, which in turn defines the coverage 
area. To close the polygon and fill the defined area with segments, double click with the 
left mouse button.  
 
 
The Define Coverage by Latitude/Longitude Coordinates button defines an area 
bounded by specific latitude and longitude points. When a user clicks this button, a  
Latitude/Longitude Entry window (figure 14) pops up. Enter each geographic coordinate  
pair in decimal degrees (latitude, longitude), then click Add LAT/LON. As each pair is 
added, MMCPC will list it in the Latitude/Longitude Entry window. The user can edit the 
entries as follows before accepting the coverage area:  
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• To edit a record, select the entry in the list (the Add LAT/LON button will  automatically rename 
to Change LAT/LON), edit the latitude and/or longitude  value(s) and click Change LAT/LON.   

• To delete a record, select the entry in the list and click Remove LAT/LON.   
• When all coordinates are listed correctly, click OK. The main MMCPC window  will return, and 

the defined composition will appear on the world map.   
• To exit from the Latitude/Longitude Entry window and not save the points as a  composition, 

click Cancel. The main MMCPC window will return.  
  
  

 
Figure 14 Latitude/Longitude entry window 

  
 
The Set/Clear button individually selects segments to be added to—or deleted from—a 
composition. In other words, this button acts as a toggle to select and deselect individual 
segments.  
   

 
  

Erase an Area of Coverage: These three buttons are deactivated until the user has defined at 
least one area of coverage with one or more of the Define Coverage buttons. Use any combination 
of the following buttons to erase areas of map coverage (i.e., remove coverage from a map theater 
composition).  

  
  
The Erase Coverage by a Stretch-Box button erases a rectangular area of coverage in 
the same way that the Define Coverage by a Stretch-Box button works.   
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The Erase Coverage by Clicking Polygon Vertices button erases an irregularly shaped 
area in the same way that the Define Coverage equivalent works.  

  

The Erase Coverage By Latitude/Longitude Coordinates button erases an area 
bounded by specific latitude and longitude points in the same way that the Define 
Coverage equivalent works, using the Latitude/Longitude Entry window.  
  

 
  

4.3. Main Menu  
  
The top menu bar (main menu) provides drop-down menus for the main operations of 
MMCPC.  
  

4.3.1. File  
  

The File menu (figure 15) lets a user create, open, close and save a composition, import a map 
composition, review a map theater build, and exit from MMCPC. The export function is not 
supported in MMCPC v2.0. 
   

 
Figure 15 File menu  

 
4.3.1.1.  New (Ctrl-N or Alt-FN)  

  
This option, also available via the Create a New Composition button on the tool bar (Section 
4.2.2.1), enables map composition drawing tools in preparation for building a map composition. 
See the Open option (below) for alternatives to New. If a user designs a composition and does 
not save it before selecting New, MMCPC will issue a warning to save the work prior to starting a 
new file.  
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4.3.1.2.  Open (Ctrl-O or Alt-FO)  
 
This option, also available via the Opens an existing composition button on the tool bar (Section 
4.2.2.1) opens, a file containing a map composition. When the user selects Open, MMCPC 
displays a list of compositions from which to choose (figure 16), after which MMCPC returns to 
the base map and displays the selected composition (figure 17). At this point, the user can view 
the map data defined by the composition (via the View RPF Data selection from the right mouse 
button menu) or modify the composition.  
 

 

 
Figure 16 Sample list of compositions 

  
 
  

 
Figure 17 Sample composition displayed on the MMCPC base map 
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4.3.1.3.  Close   
  

This option closes the current composition and refreshes the main MMCPC window. If the user 
has made unsaved changes, MMCPC will issue a warning and provide an opportunity to save the 
work prior to closing.  
  

  
4.3.1.4. Save (Ctrl-S or Alt-FS)  

  
This option, also available via the Save File button (Section 4.2.2.1), saves the current 
composition as a working file, with no associated map theater specifics. MMCPC does not place 
any size restrictions on these files, so the user may save a large “master” composition as a 
working file, and then break it into smaller compositions for final files.   

  
MMCPC prompts the user for the final filename, which must be 10 characters or less with only 
Modified ASCII (MASCII) alphanumeric characters (i.e., A–Z, 0–9). The full MASCII symbol set is 
provided in Appendix B. Note that if the status of the file is locked, it cannot be overwritten and 
must be given a different name. A new composition is always saved in an unlocked state, which 
indicates the composition has not been used to create a map theater. Once a composition has 
been successfully used to create a map theater, MMCPC automatically changes the state of the 
composition to locked, after which no changes can be made to that composition. This process 
enables the MMCPC user to track a map theater based on its corresponding locked composition. 
When map sources are removed from MMCPC, any locked compositions referencing those 
sources will automatically be marked obsolete, indicating a map theater may no longer be exactly 
replicated because one or more originally referenced map sources are no longer available. If the 
user tries to save a composition with an unlocked composition filename that already exists, 
MMCPC will ask if the user wants to overwrite the preexisting file.  

  
4.3.1.5.  Save As (Alt-FA)  

  
This option saves the current composition with a new filename in an unlocked state. MMCPC 
does not place any size restrictions on these compositions, so the user may save a large “master” 
composition and later break it into smaller compositions for map theater builds. Filename 
restrictions are described above in Section 4.3.1.4.  
 

  
4.3.1.6. Import/Export (Alt-FI)  

  
This option, also available via the Import/Export button (Section 4.2.2.1), imports map 
compositions in ASCII format. The Mission Planning System (MPS) format required for import is 
defined in Appendix C.  The export portion of this function is not supported in MMCPC.  
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4.3.1.7.  Review Build 
 
This option provides the ability to review a map theater build that resides on the hard drive or on 
a PCMCIA card via a pop-up dialog window. If the hard drive is selected, MMCPC displays a list 
of available map theaters (named by composition) that exist on the hard drive for MMCPC.  Once 
a map theater is selected, geographic coverage of the data contained for that map theater is 
displayed in light blue tiles by scale. If a PCMCIA card is selected, the coverage shown represents 
only what resides on the specific card loaded for the PC drive. In the case where a map theater 
spans two cards, total coverage is only partially represented on each card. 
 
4.3.1.8.  Print (Ctrl-P or Alt-FP)  

  
This option print the contents of the screen.  
 

  
4.3.1.9.  Exit (Alt-FX)  

  
This option closes the current composition and exits from MMCPC. If the user has made unsaved 
changes, MMCPC will issue a warning and provide an opportunity to save the work prior to 
closing.  

  
 
 

4.3.2. View  
  

The View menu (figure 18) includes options to refresh the display and overlay shorelines, latitude 
and longitude grid, available data coverages, and zoom. Some options are selected with a toggle 
button that shows a check mark when chosen. These options can also be invoked via hot keys.  
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Figure 18 View menu 

 
 

4.3.2.1. World Map (Alt-VW)  
  

World Map is the base map for MMCPC and a standard product from the National Geospatial-
Intelligence Agency (NGA). This overlay draws the shorelines of the world and is ON by default 
(figure 19). When this option is toggled off, MMCPC will not draw the World Map.  

  
  
  

 
Figure 19 MMCPC base world map 
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4.3.2.2.  LAT/LON Grid (Alt-VG)  

  
This option displays a user-defined grid of latitude and longitude lines. When the user turns this 
overlay ON, MMCPC will overlay the grid on the World Map. Default grid spacing is 45° (latitude 
and longitude), but the user can change this (Section 4.3.2.6). Figure 20 shows the LAT/LON Grid 
ON with a 20° grid.  

   
  

 
 

Figure 20  MMCPC base map with latitude/longitude grid overlay ON  

 
4.3.2.3. Available Coverage (Alt-VC) 

  
This option displays all logged data coverage for the current map type and scale. All available 
coverage is shown in green (figure 21). The user may click through the map scale drop-down box 
(figure 8) to see the available coverage at each map scale.  
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Figure 21 Available coverage of data sources overlay 

  
 

4.3.2.4.  Zoom Options (Alt-VZ)   
  
These options allow a user to zoom into (or out from) an area of interest on the world base 
map with zoom tool buttons (figure 9). Zooming can also be performed by clicking on one of 
the zoom icons on the tool bar (see Section 4.2.2.3).  
 
  

4.3.2.5. Refresh (Ctrl-H or Alt-VR)  
  
This option redraws the current map information in the MMCPC window. 
  
  

4.3.2.6. Properties  
  
The Properties option allows adjustment of geospatial coordinate grid spacing and display 
format.  
  
LAT/LON Grid Spacing:  This window (figure 22) allows the user to adjust the grid spacing of 
geospatial coordinates (the default is 45° in latitude and longitude).  
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Figure 22 Space adjustment of latitude and longitude grid lines 

  
  
  

LAT/LON Format: This window (figure 23) allows the user to change the default latitude and 
longitude format from degrees, minutes, and seconds to decimal degrees for display of the 
cursor’s geospatial position on the MMCPC base map.  

  
  
  

 
Figure 23 Adjustment of latitude and longitude coordinate format 
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4.3.3. Log  
  

The Log menu (figure 24) provides utilities to catalog data in the MMCPC source database. These 
options can also be invoked via shortcuts or hot keys.  
 

 
Figure 24  Log menu 

 
  

4.3.3.1. Log Source (Ctrl-L or Alt-LL)  
  

This option logs new sources in the MMCPC source database. A browser allows data to be logged 
from CD-ROM, the hard disk, or networked sources (figure 25) and all data must be logged with 
this function.  

  
  

 
Figure 25 Log source data window 

  
4.3.3.2. Unlog Source (Alt-LU)  

  
This option removes references to source data from the MMCPC log file (figure 26). For example, 
when a previously logged source is found to be bad (e.g., an unreadable CD-ROM) or when older 
map data becomes obsolete. Un-logging map data will render obsolete any compositions that 
included that data. The unlog function should be used primarily to manage the obsolescence of 
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map data. In turn, this will allow MMCPC to automatically manage the state of MMCPC 
compositions.  

  
  

 
Figure 26 Unlog source data window 

  
 
   

4.3.4. Compose  
  

The Compose menu (figure 27) provides additional utilities to create and modify compositions or 
to verify the size of a current composition. Note: To begin creating a composition, click on the 
New icon (Section 4.2.2.1) to activate all composition tools (Section 4.2.2.5). 

  

 
Figure 27 Compose menu 

  
  
  

4.3.4.1. Include Coverage (Alt-CC)  
  

This option allows the user to include logged sources or other compositions in the construction of 
a new composition (figure 28).  
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Figure 28 Compose menu, Include Coverage option 

  
  
  

Logged Source  
  

This option provides the capability to include logged sources in the construction of a composition. 
Valid source coverages include CADRG data that have been previously logged into MMCPC. 
MMCPC will present a list of logged sources available for selection. To select multiple logged 
sources at once, click one logged source, then depress the CTRL or SHIFT key while clicking on 
others.   
 

  
Composition  

  
This option provides the capability to include other compositions in the creation of a new 
composition. MMCPC will present a list of available compositions for user selection. Valid 
composition file types are locked, unlocked, and obsolete; users may select any of these files. To 
select multiple compositions at once, click one composition, then depress the CTRL or SHIFT key 
while clicking on others.   

  
 

4.3.4.2. Verify Composition (Alt-CV)  
  

This option verifies that the active composition is within the proper size constraints for a map 
theater (figure 29). MFDC map theaters are configurable by the size of their PCMCIA cards and 
typically have a maximum of two cards.  A configuration file exists that can be modified, but the 
default value is 2GB PCMCIA card size with a maximum of two cards (4GB total map theater 
size). If the composition is within the maximum size constraints, the user can continue and use it 
for a map theater. If the composition exceeds the required limits, the user must make 
modifications (e.g., delete data) until it is within size constraints prior to building the map theater.  
Note:  MMCPC performs a final verification of the selected composition as part of the map theater 
build. Therefore, this size verification procedure is not required, but is provided as an informational 
tool for use in constructing a composition.  
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Figure 29 Verify Composition message 

 
 

4.3.5. Build  
  

The Build menu (figure 30) provides utilities to create map theater loads. Some of these options 
can also be invoked via shortcuts or hot keys.  

  
  
  

 
Figure 30 Build menu 

  
  
  

4.3.5.1. Build Map (Ctrl-B or Alt-BB)   
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This function, also available via the Build a Map button (Section 4.2.2.4), acquires the necessary 
map data represented by the selected composition and writes that data in the MFDC format. If 
the current composition has not been saved, a prompt will appear to save and name the 
composition before proceeding. Only unlocked compositions may be selected to create a map 
theater via the browse button. Further, if an unlocked composition has not yet been verified for 
size constraints, MMCPC will verify its size before proceeding and notify the user if the 
composition is too large.  See Section 5.4 for additional information on building and writing map 
data.  

  
4.3.5.2. Write Theater Map (Alt-BW)   

  
This function, also available via the Write a Theater Map button (Section 4.2.2.4), is used to 
transfer any map theater from the MMCPC-reserved directory for map theaters  to PCMCIA cards. 
Once a map theater resides in the MMCPC-reserved directory, it may be written to PCMCIA cards 
as many times as needed. See Section 5.4 for additional information on building and writing map 
data.  

  
4.3.5.3. Theater/Mission Summary (Alt-BT)  

  
This option provides an information window that summarizes all map theaters currently residing 
on hard disk. Mission data loads are not supported in this version of MMCPC. 

  
  
 
 

4.3.6. Help  
  

The Help menu (figure 31 provides information about errors, warnings, and other messages 
issued by MMCPC, and general information about MMCPC.  

  
  

 
Figure 31 Help menu 

 
  
4.3.6.1. History Display  
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This option displays the MMCPC history log file (figure 32), which includes all errors, warnings, 
and other messages issued by MMCPC. To print this file (while it is displayed in the History Log 
window), go to the File menu and click on Print (Section 4.3.1.7), or type Ctrl-P or Alt-FP.  

  

        
Figure 32 MMCPC history processing log file 

 
  

4.3.6.2. About MMCPC  
  

This option displays technical point of contact information and the MMCPC release statement.  
5. COMMON OPERATIONS  

  
5.1. Common Operations Overview  

  
Most MMCPC users will be concerned primarily with using the composition functions to develop 
a map theater to write to PCMCIA cards based on a particular region of interest at certain CADRG 
map scales. The following sections step through frequently used key operations. Note: this is not 
a comprehensive list of all functions supported by MMCPC.  

  
5.2. Logging Map Data   

  
This section lists steps for logging map data. See Section 4.3.3 for additional information on Log 
menu options. All map data sources must be logged before any map compositions can be built. 
Map data sources are logged via the Log menu.  

  
MMCPC can log valid map data from any location accessible via the standard Windows browse 
function. 
  
Perform the following steps to log data into MMCPC: 
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1. From the main menu, click Log, then Log Source, or type Ctrl-L or Alt-L (Section 4.3.3). 
MMCPC will display a browser for defining the directory path to the data (figure 33). For 
CADRG data, the user should browse to one-directory level above the RPF directory.  Note:  
The use of commas “,” in any directory path of a logged data source is prohibited.  
Commas are treated as delimiters in MMCPC path names and will result in incorrect 
logging results.  

 
2. Verify that a checkmark appears next to the Found Valid Source Data box and that the correct 

label name appears. The label name should be the same name as the directory immediately 
above the RPF directory. 
  

3. Click the Log button to log the data.  
  

 
Figure 33 Log data browser 

 
5.3. Map Composition  

  
This section describes methods to design and create map compositions. A map composition 
defines all geo-referenced map data selected to exist on its corresponding map theater. Each 
map composition is a set of user-defined regions of interest that may span multiple map scales. 
The methods described below may also be used in combination to create a composition.  

  
5.3.1. Define a Composition Using Logged Sources  

  

1. From the MMCPC main menu, click Compose, then Include Coverage, then Logged Source 
(figure 34). “Composing Mode” is now displayed in the lower-right portion of the screen. 
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Figure 34 Listing of logged source data 

 
2. Verify the map coverage:  

a. Double click on a source and verify that map coverage over the appropriate geographic 
area is displayed (figures 35a and 35b). A logged source may contain multiple map scales.  

b. Repeat for each scale. The user may need to adjust settings in the MMCPC Scale box 
(Section 4.2.2.2).  

 

             
Figure 35 Data coverage verification 

(a) Showing coverage for CADRG data at the 1:2M scale; (b) Viewing CADRG data for this 
scale 

 
 

3. From the MMCPC main window, click File, then Save. Enter a composition name. The 
composition will be saved as an unlocked composition. Click OK.  

4. From the main window, click File, then Close.  

  

( a)    (b)    
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5. From the main window, click File, then Open. Double-click on the newly saved composition 
and verify that all map data (of all types and scales) included in the composition were properly 
saved.  

6. From the main window, click Compose, then Verify Composition (Section 4.3.4) Review the 
popup dialog (figure 36) to make sure your map composition fits within the size constraints 
pre-defined in your configuration, then Click Ok.  If needed, adjust your composition size 
accordingly.  

NOTE:  The calculation used to determine maximum map theater size and theater card size, 
are defined in a configuration file that may be modified. The current maximum capacity setting 
for theater map cards is 2.0 GB. Once verified, click File, then Close.  

  
  
  

  
Figure 36 Verification of current composition 

 
  

5.3.2. Define a Composition Using Another Composition  
 

1. From the MMCPC main window, click Compose, then Include Coverage, and then 
Composition. Double-click a composition name. This name will appear in the Composition 
Name field. Click Ok. 

2. From the MMCPC main window, click File, then Save. Enter a composition name. The new 
composition will be saved as an unlocked composition. Click OK.  

3. From the main window, click File, then Close. Verify the composition has been closed.  

4. From the main window, click File, then Open. Double click on the newly saved composition. 
Verify that all of the map data included in the composition was properly saved. This new 
composition should contain exactly the same map coverage as the composition that was 
included.  

5. From the main window, click Compose, then Verify Composition (Section 4.3.4) Review the 
popup dialog (figure 35) to make sure your map composition fits within the size constraints 
pre-defined in your configuration, then Click Ok.  If the composition is too large, the user may 
remove coverage via the Erase an Area of Coverage function (Section 4.2.2.5).  
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6. Once verified, click File, then Close.  
  
 
  

5.3.3. Define a Composition Using the MMCPC Composition Toolbar  
  

1. From the MMCPC main window, click File, then New.  

2. Show all available map coverage by clicking View from the main menu. A checkmark should 
be displayed next to Available Coverage showing that it has been toggled on (Section 4.3.2). 
If it is not displayed, click Available Coverage. Using Scale drop-down menus (Section 
4.2.2.2), click through each map scale selection. Note that the color of the map coverages 
shown is green (figure 37). This indicates that the coverage shown is available but not part of 
the current composition (map segments are displayed in red for compositions).  

 

 
 

Figure 37 Area of available coverage for a new composition. The green-colored grid indicates 
coverage is available but not yet part of the current composition 

 
 

3. Use the Zoom-in on a Stretch-Box tool (Section 4.2.2.3) to zoom into a region of interest. 
Depress the left mouse button at the upper left corner of the region of interest and drag to the 
lower right corner of the area to create the desired zoom box.  

4. Click the Zoom-in on a Stretch-Box tool again to return the cursor to an arrow.   

5. Select a Scale (e.g., CADRG data at 1:5M scale). Green map segments should be displayed 
for the entire areas of existing available coverage.  
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6. Use the Define Coverage by a Stretch-Box tool (Section 4.2.2.5) to select an area. Depress 
the button to activate the function, hold down the left mouse button at the upper left corner of 
the region of interest and drag to the lower right corner of the desired coverage. A purple box 
will be displayed showing the extents of the stretch-box, and the color of the map segments 
within the intersecting box should now be red (indicating that these map segments are part of 
the current composition, figure. 38a).  

7. The map scale can be changed to include additional data at other scales by repeating step 
(2) for each scale.  

8. Use the Erase Coverage by a Stretch-Box tool to remove unwanted coverage (Section 
4.2.2.5). Depress the button to activate the function, hold down the left mouse button in the 
upper left corner of the region of interest and drag to the lower right corner of the desired 
coverage. A purple box should be displayed showing the extents of the stretch-box, and the 
map segments within the box will now be removed (figure. 38b).  
 
Note regarding different scales: Actions taken at one scale are not automatically applied to 
the others. Verify that any changes on one scale do not adversely affect the coverages of 
another.  

  
  

 
 

Figure 38 Defining a composition area of coverage. 
(a) Defined coverage area is red, available data is green; (b) a portion of coverage is erased to 

redefine the composition area. 
  

 
5.4. Map Theater Build  

  
This section includes methods to build and write an MFDC map theater (Section 4.3.5). Each 
MFDC map theater includes the following configurable parameter and symbol set files:  DMU.INI, 
MFDC130, OVERLAY.PAL, and SYMBOL.DAT.  These files are permanently stored in the 
/system/mfdc subdirectory under the main MMCPC executable directory.  

  
In MMCPC, all map theaters are first written to hard disk. Map theaters may then be written to 
MFDC PCMCIA cards.  

 

( a)    (b)    
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The PCMCIA card size is significant because a map theater may span two cards. When this is 
the case, the MFDC data structure containing map files for a map theater must be sized to fit each 
card without any one CADRG scale spanning across both cards. MMCPC reads a configuration 
file that specifies the card size. This, in turn, affects the map composition verification process to 
ensure that the resulting map theater will fit within the PCMCIA card constraints.  Should the 
PCMCIA card size change in the future, this parameter file will require modification.  
 
Note:  MMCPC assumes the PCMCIA card size is the same for both cards.  Should lower 
capacity cards (e.g. 1.0GB) be used than what has been configured (2.0GB by default), the 
map composition verification process will not be able to adequately verify whether a 
resultant map theater can actually be written to those lower capacity PCMCIA cards and 
may fail during write. 

  
 
 

5.4.1. Build Map Theater 
  

1. From the MMCPC main menu, click Build, then Build Map. A Build Map window is displayed 
(figure 39). If a composition is open, the user will be prompted to save it before the Build Map 
window is displayed. The open composition will be the default composition shown in the Build 
Map window.  

  
 

  
Figure 39 Build Map window 

 
 
The user may also click Browse and choose any other unlocked composition that exists within 
MMCPC (figure 40). The dialog is updated to show the selected composition name. Click Ok. 
Note there is a 4 GB size limit for builds by default configuration. Once the build is complete, the 
composition will be locked. 
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Figure 40 Build map composition browser (Note: Locked composition types may not be 
selected) 

 
 

2. The Build Map window then closes and the Data Sources window is displayed (figure 41). 
This window shows all possible map sources for the selected composition. Click OK to accept 
the default order of sources.  
  
  

 
Figure 41 Build map data sources window 
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NOTE:  Map data sources may have overlapping coverage. The Data Sources window allows 
the user to set the order of precedence of the data sources that will be used to construct the 
map build (top is highest priority). Order of precedence may be important when newer map 
data overlaps older data or when prioritizing the source provider. The user may change the 
order of precedence by clicking (i.e., selecting) a particular source and using the Up and Down 
buttons to set the order.  
  
  

3. The build process will begin. For sources on CD-ROM, MMCPC requests the user to insert 
the CDROM or to locate an alternate location (figure 42) and click OK to continue. When the 
window appears indicating the build is complete, click OK (figure 43). MMCPC will write the 
map theater as discussed in the following section.  
  
  

 
Figure 42 Build map data source locator 

   
 
 

 
Figure 43 Build map completion message 

 
 

5.4.2. Write Map Theater to PC Card(s)  
  

1. From the MMCPC main window, click Build, then Write Theater Map. Double click on the 
name of map theater to be written (figure 44). Note that the map theater name is the same as 
its corresponding composition, including its two-digit edition number. “Building Mode” is now 
displayed in the lower-right portion of the screen. 
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Figure 44 Write theater map browser 

   
  

2. The PCMCIA card drive dialog appears (figure 45). Enter a disk into the pre-configured 
designated drive and click OK. 

  

 
Figure 45 PC card window 

 
3. When the write operation requires a single card load, click OK after the write has completed. 

Eject the card from the PC card drive and label this card with a descriptive title.  
  
4. When the write operation spans two cards, the user will be prompted to insert the next card if 

needed. Eject the first card and label it with a descriptive title, and insert it into the PC card 
drive.  
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Appendix A   ACRONYMS AND TERMS  
 

  
ASCII   American Standard Code for Information Interchange 
CADRG  Compressed Arc Digitized Raster Graphics  
GB    Gigabytes  
GEOTIFF  Geo-referenced Tagged Image File Format  
MASCII  Modified American Standard Code for Information 

Interchange  
MFDC Map File Data Cartridge  
MMCPC  Moving-Map Composer–Personal Computer  
MPS    Mission Planning System  
NAVAIR  Naval Air Systems Command  
NGA    National Geospatial-Intelligence Agency  
NRL    Naval Research Laboratory  
PCMCIA  Personal Computer Memory Card International 

Association  
RPF Raster Product Format 
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Appendix B  MODIFIED ASCII SYMBOL SET  
  

Code (Decimal)  Character  Code (Decimal)  Character  Code (Decimal)  Character  
0  Space  43  %  87  reserved  
1  A  44  ,  88  reserved  
2  B  45  °  89  reserved  
3  C  46  .  90  reserved  
4  D  47  /  91  reserved  
5  E  48  0  92  reserved  
6  F  49  1  93  reserved  
7  G  50  2  94  reserved  
8  H  51  3  95  reserved  
9  I  52  4  96  reserved  
10  J  53  5  97  reserved  
11  K  54  6  98  reserved  
12  L  55  7  99  reserved  
13  M  56  8  100  reserved  
14  N  57  9  101  reserved  
15  O  58  =  102  reserved  
16  P  59  reserved  103  reserved  
17  Q  60  reserved  104  reserved  
18  R  61  reserved  105  reserved  
19  S  62  reserved  106  reserved  
20  T  63  reserved  107  reserved  
21  U  64  reserved  108  reserved  
22  V  65  reserved  109  reserved  
23  W  66  reserved  110  reserved  
24  X  67  reserved  111  reserved  
25  Y  68  reserved  112  reserved  
26  Z  69  reserved  113  reserved  
27  \  70  reserved  114  reserved  
28  reserved  71  reserved  115  reserved  
29  reserved  72  reserved  116  reserved  
30  reserved  73  reserved  117  reserved  
31  reserved  74  reserved  118  reserved  
32  reserved  75  reserved  119  reserved  
33  “  76  reserved  120  reserved  
34  ?  78  reserved  121  reserved  
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35  :  79  reserved  122  reserved  
36  #  80  reserved  123  reserved  
37  -  81  reserved  124  reserved  
38  +  82  reserved  125  reserved  
39  ‘  83  reserved  126  reserved  
40  (  84  reserved  127  reserved  
41  )  85  reserved  N/A  N/A  
42  *  86  reserved  N/A  N/A  

  

  



 

42 
 

Appendix C  MPS IMPORT FILE FORMAT 
 

The MPS import is an ASCII file that serves as an interface between a mission planning system 
and MMCPC. The mission planning system import can be used to create a composition and 
process data frames in MMCPC based on the contents of the MPS-ASCII file. All import files must 
end with an extension of “MPS”.  

  
MMCPC reads the MPS import file (defined below) and creates an MMCPC composition from the 
file’s contents. The user may import an MPS file into MMCPC from any available directory or hard 
drive. Further, source files for data frames listed in an MPS file may exist in any available directory 
or hard drive available to MMCPC.  

  
A file folder will exist with the name given in the file. The MPS import file format is shown in figure 
46 and is comprised of three sections: header, data, and location. Figure 47 presents an example 
of an import file.  

  
The header section contains the unique mission name that will be assigned as the MMCPC 
composition name. The maximum name length is 10 characters and it cannot include spaces or 
special characters. This is accompanied by an integer that indicates the number of data sections 
to follow. An exclamation point (!) in the first column indicates that the line is a comment field and 
the entire line is ignored during import.  

  
The data section consists of information to identify the map data type, map scale, and 
source/destination directories for data frames. Valid map data types include CADRG only. Valid 
map scales for these data types are listed in Table 1.  

  
The location subsection is applicable to CADRG. The first entry in this section lists the number 
of coordinates that will follow for that particular data section (e.g., CADRG @ 1:2M). This is 
accompanied by a series of latitude and longitude coordinates that are specified in +/- decimal 
degrees and delimited by commas.   
 

  
{Header section}  
<Unique Identifier> (e.g. MPS0001)  
{Data section}  
  <Data Type>  (CADRG,)  
  <Scale>  
   <Number of lat / lon points>  
  {Location subsection} (CADRG with max. of 256 defined points)     <Lat, Lon> 
(Decimal degrees [dd.ddd,ddd.ddd])  
  }        
}  
! Indicates comment field  

Figure 46 MPS Import file format 
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Table 1 Valid data types and map scales 

Data Type  Map Scale  

CADRG  

1:12.5k  
1:50k  
1:100k   
1:250k   
1:500k   
1:1M  
1:2M  
1:5M  

  
 
 
  

 ATP4  
! Composition title  
2 
! Number of sections to follow  
! CADRG has 8 scales [1:12.5k,1:50k,1:100k,1:250k,1:500k,1:1M,1:2M,1:5M]  
CADRG  
1:250k  
4  
61.5,024.5 
62.5,024.5 
62.5,025.5  
61.5,025.5  
CADRG  
1:2M  
4  
61.5,024.5 
62.5,024.5 
62.5,025.5  
61.5,025.5  
  

 
Figure 47 MPS import file example (MPSIMPORT.MPS) 
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